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Warranty – Seller warrants all goods for five years on parts and 2-1/2 years 
on labor, under the following conditions and exceptions: Seller warrants that 
all goods of Seller's manufacture will conform to any descriptions thereof for 
specifications which are expressly made a part of this sales contract and at the 
time of sale by Seller such goods shall be commercially free from defects in 
material or workmanship. Seller reserves the right at the Seller’s discretion to 
“Repair and Return” or “Replace” any item deemed defective during the war-
ranty period. This warranty does not cover travel expenses, the cost of special-
ized equipment for gaining access to the product, or labor charges for removal 
and reinstallation of the product. This warranty shall be ineffective and shall not 
apply to goods that have been subjected to misuse, neglect, accident, damage, 
improper maintenance, or to goods altered or repaired by anyone other than 
Seller or its authorized representative, or if five years have elapsed from the 
date of shipment of the goods by Seller with the following exceptions: lamps 
and strobe tubes are not covered under this warranty. Outdoor warning sirens 
and controllers manufactured by Federal Warning Systems are warranteed for 
two years on parts and one year on labor. No agent, employee, representative 
or distributor of Seller has any authority to bind the Seller to any representation, 
affirmation, or warranty concerning the goods and any such representation, af-
firmation or warranty shall not be deemed to have become a part of the basics 
of the sales contract and shall be unenforceable. THE FOREGOING WAR-
RANTIES ARE EXCLUSIVE AND IN LIEU OF ALL OTHER WARRANTIES 
OR MERCHANTABILITY, FITNESS FOR PURPOSE AND OF ANY OTHER 
TYPE, WHETHER EXPRESS OR IMPLIED. These warranties shall not apply 
unless Seller shall be given reasonable opportunity to investigate all claims for 
allegedly defective goods. Upon Seller's instruction a sample only of allegedly 
defective goods shall be returned to Seller for its inspection and approval. 
The basis of all claims for alleged defects in the goods not discoverable upon 
reasonable inspection thereof pursuant to paragraph 8 hereof must be fully 
explained in writing and received by Seller within thirty days after Buyer learns 
of the defect or such claim shall be deemed waived.

Federal Signal Corp.
Industrial Systems
2645 Federal Signal Drive • University Park, IL 60484-3167
Tel: 708-534-4756 • Fax: 708-534-4852
Email: elp@federalsignal.com • www.federalsignal-indust.com
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SelecTone is a registered trademark of Federal Signal Corporation

InstallShield is a registered trademark and servicemark of InstallShield Corporation in the  
United States or other countries

Windows is a registered trademark of Microsoft Corporation in the United States  
and other countries.
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An Overview of the Model 300FP-SD

The Federal Signal Model 300FP-SD SelecTone® Field Programmer 
application copies audio files from your computer to the Federal Signal 
RMB9999 message chip on the SelecTone Field Programmer. The 
message chip stores up to 30 seconds of audio. 

Audio files are created with the Sound Recorder application available 
with Windows® XP, Windows Vista, and Window 7, or with a third-party 
sound recording/editing program. The message chips are compatible 
with the Federal Signal CommCenter® and Model TM33 Speaker 
Module and can be reused and reprogrammed.

The SelectTone Field Programmer features include a message-chip 
insertion mechanism that easily locks the chip in place, message 
playback, and volume control. LED indicators show when the 
programmer is powered on (green) and the duration of playback 
(red). The red playback LED flickers rapidly when the SelecTone Field 
Programmer attempts to play back a blank message chip. 

The package contents includes:

Description Part Number

300FP-SD SelecTone Field Programmer 2005625
120 Vac to 24 Vdc Power Adapter 120834
RS-232 Serial Cable 1751156
Installation CD 8503058

Federal Signal message chips are purchased separately under part 
number RMB9999.

Product Detail

Power Adapter:
Input: 110 V–120 V, 50/60 Hz

UL Listed

Audio Requirements: WAV
MP3
WMA (with Windows Media Player installed)
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Computer Requirements:

Windows XP, Windows Vista, or Windows 7
Screen resolution: 1024 x 768 pixels, 32 bit
Hard drive free space: 20 MB
One free serial port
64 MB graphics card
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Installing the Software

To install the SelecTone Field Programmer software:

1.	 Insert the installation CD into the CD/DVD drive of your computer.

2.	 If the Autorun option is disabled, double-click the file setup.exe on 
the CD.

3.	 If your system does not have Microsoft .NET Framework 3.5 SP1 
runtime installed, the InstallShield® Wizard prompts you to install it. 
Click Install.

If your system has the required .NET Framework components, skip 
to step 5.
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4.	 The .NET Framework files will take a few minutes to install.

Note: You may be required to restart your computer once the 
installation is complete.

5.	 When the InstallShield® Wizard appears for the SelecTone Field 
Programmer software, click Next.

6.	 Follow the on-screen instructions to complete the installation. 
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Exploring the Interface

Programming message chips with the SelecTone Field Programmer 
application is fast and easy. Everything you need is contained in one 
window for this simple, three-step programming process: 

Step 1	 Select the computer serial port that connects to the 
SelecTone Field Programmer.

Step 2	 Select an audio file to program to the message chip.

Step 3	 Begin programming.

In addition, the application marks each step you successfully complete 
with a green check mark (✔ = pass). To ensure that the audio file is 
copied properly, the application stops the process at the first step that 
contains an error and marks the step with a red X (✖ = fail).

Minimize and Close 
buttons

Options 
Menu

Process  
Status 

Message

Refresh
Button

Browse 
Button

Program  
Step 1

Program  
Step 2

Program  
Step 3
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The Minimize (–) and Close (X) buttons in the upper right corner work 
the same way as their counterparts in other Windows programs. The 
Minimize button shrinks the application to an icon on the taskbar 
without closing it. When you are ready to work with the application, 
you can quickly access it by clicking the icon. Clicking the Close button 
closes the application.

Buttons that are familiar from other Windows-based programs are the 
Refresh button in Step 1 and the Browse button in Step 2. Click the 
Refresh button to update the list of available serial ports. Click the 
Browse button to navigate to the audio file you want to program to the 
message chip.

The Status box at the bottom of the window provides detailed 
information about the success or failure of each step.

Options Menu
The SelecTone Field Programmer application has a menu of options 
that enables you to change the language of the interface, manage 
files, and set up the programming for message chips. The four 
submenus and their functions are:

File

Open Opens an audio file

Exit Closes the application

Edit

Cut Cuts text in application fields such as file 
names and status messages

Copy Copies text in application fields

Paste Pastes text in application fields

Tools

Audio File 
Information

Displays the audio file type, sample rate, 
and number of bits

Audio Channel Selects the audio channel for downloading 
to a message chip

Refresh Serial  
Port List

Re-scans the computer for available serial 
ports. Works the same way as the Refresh 
button in Step 1.

continued
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Options Menu (continued)

Tools

Language Changes the language of the application 
interface to English (default), French, or 
Spanish

Help

About... Displays the model number of the 
SelecTone Field Programmer, the version 
number of the software, and Federal 
Signal copyright information

Exploring the Interface
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Preparing to Program a Message Chip

To prepare the Model 300FP-SD for programming:

1.	 Connect the serial cable between the serial port on your computer 
and the serial connector on the SelecTone Field Programmer.

2.	 Connect the power adapter cable between a 120 Vac power 
source and the power connector on the SelecTone Field 
Programmer.

3.	 Insert a blank message chip with the notch to the left side of the 
SelecTone Field Programmer. 

4.	 When the chip is completely seated, flip the lever to the left and 
down to secure the chip.

Serial cable  
to computer

Green LED 
is on when 

power is on

Message chip  
inserted with  

notch to the left

Power adapter to 
power source

Lever is in  
lock position

Red LED is on  
when message 
chip is played; 
flickers rapidly 
when message 
chip is blank

Turn clockwise to  
increase volume;  

counter clockwise  
to decrease

Speaker
Press to begin  
playback of  
message chip
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Programming a Message Chip

The RMB9999 message chip can be reused and reprogrammed. The 
maximum length of the message is 30 seconds.

To program a message chip:

1.	 Launch the programming software by clicking the SelecTone 
Field Programmer icon on the desktop or from the Start Menu 
by selecting All Programs > Federal Signal > SelecTone Field 
Programmer.

2.	 In the programming window under Step 1, select a serial port 
through which to download the audio file. 

3.	 In Step 2, enter the path and file name of the audio file, or click the 
browse button in Step 2 to navigate to the file. Alternately, in the 
menu bar click File > Open and select the audio file you want to 
download. 

Browse  
button
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4.	 If the audio file has more than one channel, select in the Tools 
menu the Audio Channel you want to download. The default is 
Channel 1. The number of channels that are available depend on 
the selected audio file.

5.	 Click Program in Step 3 to download the audio file to the message 
chip. 

6.	 To play the recorded message, press the play button under the 
arrow on the SelecTone Field Programmer. See the figure on  
page 13.

Note: To adjust the playback volume, use a small Phillips or flat-
blade screwdriver to turn the recessed Volume control clockwise 
to increase the volume or counter-clockwise to decrease it.

7.	 Flip the locking switch to the upright position and carefully pull the 
programmed chip from the socket. 

8.	 To continue programming additional chips with the same audio 
file, you need only to click the Program button after inserting each 
blank message chip.
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Creating Audio Files with Sound Recorder

Sound Recorder is an easy-to-use utility included with the Windows 
operating system for recording and editing audio files. This chapter 
describes how to record an audio file with Sound Recorder in 
Windows XP, Windows Vista, and Windows 7. Before using Sound 
Recorder, make sure your computer is equipped with an audio sound 
card, speakers, and an audio input device, such as a microphone.

Recording an Audio File in Windows XP
The default audio input device for Sound Recorder is Microphone. 
To change the device or recording volume, see the following section 
“Changing the Audio Input and Volume (Windows XP)” on page 16.

To record and save an audio file:

1.	 Click Start > All Programs > Accessories > Entertainment > 
Sound Recorder.

2.	 To begin recording, click the Record button (red circle). 

Note: The RMB9999 message chip stores up to 30 seconds of 
audio.

3.	 To stop recording audio, click the Stop button (black square).

4.	 When finished, click File > Save.
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5.	 Click the File name box and type a name for the recorded 
sound.

6.	 Select a location for the file by clicking the down arrow next to 
the Save in drop-down box.

7.	 To save the recorded sound as an audio file, click Save.

Changing the Audio Input and Volume (Windows XP)

To change the audio input and the recording volume:

1.	 In the Sound Recorder main menu select Edit > Audio 
Properties.
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2.	 Under Sound recording, click the Volume button. 

3.	 In the Recording Control control panel, check the Select box 
under Line In or the name of another line input or device you 
are using. 
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4.	 Increase the recording Volume by moving the slider up. 
Decrease it by moving the slider down.

5.	 Close Recording Control by clicking the X button.

6.	 Close Audio Properties by clicking the OK button. 

Recording an Audio File in Windows Vista
The default audio input device for Sound Recorder is Microphone. 
To change the device or recording volume, see the following section 
“Changing the Audio Input and Volume (Windows Vista)” on page 19.

To record and save an audio file:

1.	 Click Start > All Programs > Accessories > Sound Recorder.

2.	 Click Start Recording.

Note: The RMB9999 message chip stores up to 30 seconds of 
audio.

3.	 To stop recording audio, click Stop Recording.

4.	 Select a location for the file by clicking the down arrow next to 
the Save in drop-down box.

5.	 To save the recorded sound as an audio file, click Save.
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Changing the Audio Input and Volume (Windows Vista)

To change the audio input and the recording volume:

1.	 Click Start > Control Panel > Hardware and Sound > Manage 
audio devices, and click the Recording tab.

2.	 Select Line In or the name of another line input or device you 
are using, and click Set Default. 

3.	 To adjust the volume, click Properties and click the Levels tab. 

4.	 Increase the recording volume by dragging the slider to the right. 
Decrease it by dragging the slider to the left.

5.	 When finished, click OK.

6.	 In the Sound dialog box, click OK.

Recording an Audio File in Windows 7
The default audio input device for Sound Recorder is Microphone. 
To change the device or recording volume, see the following section 
“Changing the Audio Input and Volume (Windows 7)” on page 20.

To record and save an audio file:

1.	 In the Start Search box, type Sound Recorder, and in the list 
of results, click Sound Recorder. 

2.	 Click the Start Recording button. 

Note: The RMB9999 message chip stores up to 30 seconds of 
audio.

3.	 To stop recording audio, click Stop Recording.

4.	 Select a location for the file by clicking the down arrow next to 
the Save in drop-down box.
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5.	 Click the File name box, type a file name for the recorded 
sound, and click Save to save the recorded sound as an audio 
file.

Changing the Audio Input and Volume (Windows 7)

To change the audio input and the recording volume:

1.	 Click the Start button, then click Control Panel.

2.	 In the Start Search box, type Sound.

3.	 Click Sound, then click the Recording tab.

4.	 Click Line In or the name of another line input you are using, 
and click Set Default. 

5.	 Click Properties, then click the Levels tab. 

6.	 Increase the recording volume by dragging the slider to the right. 
Decrease it by dragging the slider to the left, then click OK.

7.	 In the Sound dialog box, click OK.
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Returning the Product for Credit

Product returns for credit require a return authorization from your  local 
distributor prior to returning the product to Federal Signal. Please 
contact your distributor for assistance. 

A product is qualified to be returned for credit when the following 
conditions are met:

• 	 Product is resalable and in the original cartons

• 	 Product has not been previously installed

• 	 Product is the current revision

• 	 Product has not been previously repaired

• 	 Product is a standard product

• 	 Product is not a service part

All returns are subject to a re-stock fee.

Defective products that are returned within the warranty period will 
be repaired or replaced at Federal Signal’s sole discretion. Defective 
products do not include those products with lamp failure.

Circumstances other than those listed above will be addressed on a 
case-by-case basis.
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Obtaining Service, Assistance, and Parts

Products returned for repair require a Return Authorization form. 
To obtain service for the product, please contact the Federal Signal 
Service Department at 708-534-4858.

For technical assistance, please call Federal Signal Technical Support 
at 708-534-3424, extension 5823. 

To order replacement parts, please call Federal Signal Customer 
Support at 708-534-4756.

2645 Federal Signal Drive • University Park • IL 60484-3167
Tel: 708-534-4756 • Fax: 708-534-4852
elp@fedsig.com • www.federalsignal-indust.com
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Modelo 300FP-SD
Programador de campo  

SelecTone® Field Programmer

Instalación de software y  
programación de chip de mensajes
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Federal Signal Corp.
Industrial Systems
2645 Federal Signal Drive • University Park, IL 60484-3167
Tel: 708-534-4756 • Fax: 708-534-4852
Email: elp@federalsignal.com • www.federalsignal-indust.com

Garantía – El vendedor otorga para todos los artículos una garantía de cinco años en 
cuanto a piezas y 2 1/2 años en cuanto a mano de obra, bajo las siguientes condiciones 
y excepciones: El vendedor garantiza que todos los artículos fabricados por el vendedor 
cumplirán con las descripciones pertinentes para las especificaciones, que son parte 
expresa de este contrato de venta y que al momento de la venta por parte del vendedor 
estos artículos estarán comercialmente libres de defectos de material o fabricación. El 
vendedor se reserva el derecho a su discreción de "reparar y devolver" o de "reemplazar" 
cualquier artículo considerado defectuoso durante el período de garantía. Esta garantía 
no cubre gastos de transporte, el costo de equipos especializados para acceder al producto 
o cargos de mano de obra para la remoción y reinstalación del producto. Esta garantía no 
tendrá efecto y no se aplicará a artículos que se hayan visto afectados por uso indebido, 
negligencia, accidentes, daños o mantenimiento inadecuado, o a artículos alterados 
o reparados por cualquier otra persona que no sea el vendedor o sus representantes 
autorizados, o si han transcurrido cinco años desde la fecha de despacho de los artículos 
por parte del vendedor con las siguientes excepciones: lámparas y tubos estroboscópicos 
que no están cubiertos bajo esta garantía. Las sirenas de advertencia y los controladores 
para exteriores fabricados por Federal Warning Systems cuentan con una garantía de 
dos años para piezas y de un año en cuanto a mano de obra. Ningún agente, empleado, 
representante o distribuidor del vendedor tiene autoridad para comprometer al vendedor 
con alguna representación, afirmación o garantía con respecto a los artículos y cualquiera 
de estas representaciones, afirmaciones o garantías no podrán considerarse como parte 
de los fundamentos del contrato de venta y no serán aplicables. LAS GARANTÍAS 
ANTERIORES SON EXCLUSIVAS Y REEMPLAZAN CUALQUIER OTRA 
GARANTÍA O GARANTÍA DE COMERCIABILIDAD, APTITUD PARA EL USO Y 
DE CUALQUIER OTRO TIPO, YA SEA EXPLÍCITA O IMPLÍCITA. Estas garantías 
no se aplicarán a menos que se proporcione al vendedor una oportunidad razonable para 
investigar todos los reclamos con respecto a los artículos supuestamente defectuosos. A 
pedido del vendedor, sólo una muestra de los artículos supuestamente defectuosos será 
devuelta al vendedor para su inspección y aprobación. La base de todos los reclamos por 
los defectos que se afirman en los artículos no determinables después de una inspección 
razonable de estos según el párrafo 8 del presente debe explicarse totalmente por escrito y 
debe ser recibido por el vendedor dentro de un plazo de treinta días a partir del momento 
en que el comprador se entera del defecto o dicho reclamo será considerado como no 
aplicable.
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SelecTone es una marca registrada de Federal Signal Corporation

nstallShield es una marca registrada y el marca de servicio de InstallShield Corporation en los 
Estados Unidos u otros países

 Windows es una marca registrada de Microsoft Corporation en los Estados Unidos y otros países. 
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Descripción general del Modelo 300FP-SD

La aplicación de programación de campo SelecTone® Field Programmer 
Modelo 300FP-SD de Federal Signal copia los archivos de audio desde 
su computadora hasta el chip de mensajes RMB9999 de Federal Signal 
en el programador de campo SelecTone Field Programmer. El chip de 
mensajes almacena hasta 30 segundos de audio. 

Los archivos de audio se crean con la aplicación Sound Recorder 
(Grabadora de sonidos) disponible en Windows® XP, Windows Vista 
y Windows 7, o con un programa de grabación/edición de sonido de 
otros proveedores.

Los chips de mensajes son compatibles con el módulo CommCenter® 
de Federal Signal y con el modelo de altavoz TM33. Además, se 
pueden reutilizar y reprogramar.

Las características del programador de campo SelectTone Field 
Programmer incluyen un mecanismo de inserción que fija fácilmente 
el chip en posición, reproduce los mensajes y controla el volumen. 
Los indicadores LED muestran cuando el programador está activado 
(verde) y la duración de la reproducción (rojo). El indicador LED rojo de 
reproducción parpadea rápidamente cuando el programador de campo 
SelecTone Field Programmer intenta reproducir un chip de mensajes 
en blanco.  

El paquete contiene lo siguiente:

Descripción Número de Parte

Programador de campo SelecTone Field 
Programmer 300FP-SD

2005625

Adaptador eléctrico de 120 V CA a 24 V CC 120834
Cable RS-232 en serie 1751156
CD de instalación 8503058

Los chips de mensajes de Federal Signal se compran por separado. 
Su núm. de parte es RMB9999.
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Detalle de producto

Adaptador eléctrico:
Entrada: 110 V–120 V, 50/60 Hz

Listado en UL

Requisitos de audio: WAV
MP3
WMA (si está instalado Windows Media 
Player)

Requisitos de la computadora:

Windows XP, Windows Vista o Windows 7
Resolución de pantalla: 1024 x 768 pixeles, 32 bits
Espacio libre en disco duro: 20 MB
Un conector en serie libre
Tarjeta de vídeo de 64 MB 
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Instalación de software

Para instalar el software SelecTone Field Programmer:

1.	 Introduzca el CD de instalación en la unidad de disco CD/DVD de 
su computadora.

2.	 Si está desactivada la opción Autorun (Ejecución automática) haga 
doble clic en el archivo setup.exe en el CD.

3.	 Si en su sistema no está instalado Microsoft .NET Framework 3.5 
SP1 runtime, el asistente InstallShield® Wizard le indicará que lo 
haga. Haga clic en Install (Instalar).

Si su sistema ya tiene los componentes. NET Framework 
necesarios, avance al paso 5.
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4.	 La instalación de los archivos .NET Framework demorará algunos 
minutos.

Aviso: Quizá necesite reiniciar su computadora después de 
terminar la instalación.

5.	 Cuando aparezca el asistente InstallShield® para el software 
SelecTone Field Programmer, haga clic en Next (Siguiente).

6.	 Siga las instrucciones en pantalla para terminar la instalación.
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Explorando el interfaz

La programación de los chips de mensajes con la aplicación SelecTone 
Field Programmer es rápida y fácil. Todo lo que usted necesita está 
contenido en una ventana para este sencillo proceso de programación 
de tres pasos: 

Paso 1	 Seleccione el puerto en serie de la computadora que está 
conectado al SelecTone Field Programmer.

Paso 2	 Seleccione un archivo de audio para programar en el chip 
de mensajes.

Paso 3	 Comience a programar.

Además, la aplicación marca con un signo verde de verificación  
(✔ = aprobado) cada paso que usted ejecute con éxito. Para verificar 
que el archivo de audio se copie debidamente, la aplicación detiene el 
proceso en el primer paso que contenga un error y marca el paso con 
una X roja (✖ =reprobado).  

Botones para 
minimizar y cerrar

Menú de 
opciones

Mensaje de 
estado del 

proceso

Botón de 
regenera-
ción

Botón 
examinar

Paso 1 de 
programa

Paso 2 de 
programa

Paso 3 de 
programa
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Los botones Minimizar (–) y Cerrar (X) en el ángulo superior derecho 
funcionan de la misma manera que los botones semejantes en otros 
programas de Windows. El botón Minimizar reduce la aplicación al 
tamaño de un icono en la barra de tareas, pero no la cierra. Al estar 
listo para trabajar con la aplicación, se puede acceder fácilmente a ella 
haciendo clic en el icono. Al hacer clic en el botón Cerrar, se cierra la 
aplicación.

Los botones que son similares a los de otros programas basados en 
Windows son el botón Actualizar en el Paso 1 y el botón Examinar 
en el Paso 2. Haga clic en el botón Actualizar para actualizar la lista 
de puertos en serie disponibles. Haga clic en el botón Examinar para 
llegar hasta el archivo de audio que desea programar en el chip de 
mensajes.

La barra de Estado al pie de la ventana ofrece información detallada 
sobre el éxito o el fracaso de cada paso.

Menú de opciones
La aplicación SelecTone Field Programmer tiene un menú de 
opciones que le permite cambiar el idioma de la interfaz, administrar 
archivos y configurar la programación para los chips de mensajes. 
En la tabla a continuación se muestran los cuatro submenús y sus 
funciones:

Archivo

Abrir Abre un archivo de audio

Salir Cierra la aplicación

Editar

Cortar Corta texto en los campos de la aplicación 
tales como los nombres de archivos y 
mensajes de estado

Copiar Copia texto en los campos de la aplicación

Pegar Pega texto en los campos de la aplicación
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Menú de opciones (continuación)

Herramientas

Información del 
archivo de audio

Muestra el tipo de archivo de audio, la 
velocidad de procesamiento o “sample”, y 
el número de bits

Canal de audio Selecciona el canal de audio para 
descargar hacia un chip de mensajes

Actualizar la lista 
de puerto serial

Reexamina la computadora para detectar 
puertos en serie disponibles. Funciona de 
la misma manera que el botón Actualizar 
en el Paso 1.

Idioma Cambia el idioma de la interfaz de la 
aplicación a inglés (predeterminado), 
francés o español

Ayuda

Acerca de ... Muestra el número de modelo 
del programador SelecTone Field 
Programmer, el número de la versión del 
software, y la información de derechos de 
autor de Federal Signal



34    

Preparación para programar un chip

Preparación del Modelo 300FP-SD para la programación:

1.	 Conecte el cable en serie entre el puerto en serie en su 
computadora y el conector en serie en el programador SelecTone 
Field Programmer.

2.	 Conecte el cable del adaptador eléctrico entre una fuente de 
alimentación de 120 V CA y el conector eléctrico en el SelecTone 
Field Programmer.

3.	 Introduzca un chip de mensajes en blanco con la muesca hacia el 
lado izquierdo del SelecTone Field Programmer. 

4.	 Cuando el chip esté completamente asentado, voltee a la 
izquierda y hacia abajo la palanca para fijar el chip.

Cable en 
serie a la 

computadora 

El indicador 
LED verde se 

ilumina cuando 
el programador 
está encendido

Se introduce 
el chip de 

mensajes con la 
muesca hacia la 

izquierda

Adaptador eléctrico a 
la fuente de alimen-
tación

La palanca está 
en posición 
bloqueada

El indicador LED 
rojo se ilumina al 
reproducir el chip 
de mensajes; 
parpadea rápida-
mente cuando el 
chip está vacío

Gírelo a la dere-
cha para aumen-

tar el volumen;  
a la izquierda  

para bajarlo

Altavoz Oprímalo para 
comenzar la 
reproducción 
de un chip de 
mensajes
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Programación un chip de mensajes

El chip de mensajes RMB9999 se puede reutilizar y reprogramar. La 
longitud máxima del mensaje es de 30 segundos.

To program a message chip:

1.	 Inicie el software de programación haciendo clic en el icono 
SelecTone Field Programmer en el escritorio o desde Start Menu 
(Menú de Inicio) tras seleccionar All Programs (Todos los 
Programas) > Federal Signal > SelecTone Field Programmer.

2.	 En la ventana de programación bajo el Paso 1, seleccione un 
puerto en serie a través del cual se descargará el archivo de audio. 

3.	 En el Paso 2, introduzca la ruta de acceso y el nombre del archivo 
de audio, o haga clic en el botón examinar en el Paso 2 para 
llegar hasta el archivo. De manera alternativa, en la barra de menú 
haga clic en Archivo > Abrir y seleccione el archivo de audio que 
desee descargar. 

Botón  
Examinar
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4.	 Si el archivo de audio tiene más de un canal, seleccione en el 
menú Herramientas el Canal de audio que desee descargar. El 
canal predeterminado es el 1. El número de canales disponibles 
depende del archivo de audio seleccionado.

5.	 Haga clic en Programa en el Paso 3 para descargar el archivo de 
audio en el chip de mensajes. 

6.	 Para reproducir el mensaje grabado, oprima el botón reproducir 
debajo de la flecha en el SelecTone Field Programmer. Consulte la 
figura en la página 34.

Aviso: Para ajustar el volumen de reproducción, use un pequeño 
destornillador Phillips o de punta plana para girar a la derecha el 
control de Volume (volumen) en rebajo para aumentar el volumen 
o a la izquierda para bajarlo.

7.	 Voltee el interruptor de bloqueo a la posición vertical y extraiga 
cuidadosamente del receptáculo el chip programado.  

8.	 Para continuar programando chips adicionales con el mismo 
archivo de audio, sólo será necesario hacer clic en el botón 
Programa después de introducir cada chip de mensajes en 
blanco.

Programación un chip de mensajes
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Creación de archivos de audio con  
Grabadora de sonidos

Sound Recorder (Grabadora de Sonidos) es un programa de uso fácil 
ya incluido con el sistema operativo Windows para grabar y editar 
archivos de audio. Este capítulo describe cómo grabar un archivo de 
audio con Grabadora de sonidos en Windows XP, Windows Vista y 
Windows 7. Antes de usar la Grabadora de sonidos, cerciórese de que 
la computadora esté equipada con una tarjeta de sonido de audio, 
altavoces y un dispositivo de entrada de audio, como un micrófono.

Cómo grabar un archivo de audio en Windows XP
El dispositivo predeterminado de entrada de audio para Grabadora 
de Sonidos es Micrófono (Microphone). Para cambiar el 
dispositivo o el volumen de grabación, consulte la sección siguiente 
“Cómo cambiar la entrada de audio y el volumen (Windows XP)” en 
la página 38.

Para grabar y guardar un archivo de audio:

1.	 Haga clic en (Inicio > Todos los programas > Accesorios > 
Entretenimiento > Grabadora de sonidos (Start > All 
programs > Accessories > Entertainment > Sound 
Recorder).

2.	 Para comenzar a grabar, haga clic en el botón Grabar (Record) 
(círculo rojo).  

Aviso: El chip de mensajes RMB9999 almacena hasta 30 
segundos de audio.

3.	 Para detener la grabación de audio, haga clic en el botón 
(Parar) Stop (cuadrado negro).
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4.	 Al terminar, haga clic en Archivo > Guardar (File > Save).

5.	 Haga clic en la casilla Nombre del archivo (File name) y 
escriba un nombre para el sonido grabado.

6.	 Seleccione una ubicación para el archivo haciendo clic en la 
flecha hacia abajo junto a la casilla desplegable Guardar en 
(Save in).

7.	 Para guardar como archivo de audio el sonido grabado, haga 
clic en Guardar (Save).

Cómo cambiar la entrada de audio y el volumen  
(Windows XP)

Para cambiar la entrada de audio y el volumen de grabación:

1.	 En el menú principal de la Grabadora de Sonidos seleccione 
Edición > Propiedades de Audio (Edit > Audio Properties).

Creación de archivos de audio con Grabadora de sonidos
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2.	 Bajo Grabación de sonidos (Sound recording), haga clic en 
el botón Volumen (Volume).

3.	 En el Control de Grabación (Recording Control), marque 
la casilla Seleccionar (Select) debajo de Línea de Entrada 
(Line In) (o el nombre de otra entrada en línea o dispositivo que 
esté utilizando. 

Creación de archivos de audio con Grabadora de sonidos
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4.	 Aumente el volumen de grabación (Volume) moviendo el control 
deslizante hacia arriba. Para bajar el volumen mueva hacia 
abajo el control deslizante

5.	 Cierre Control de Grabación (Recording Control) haciendo 
clic en el botón X.

6.	 Cierre Propiedades de Audio (Audio Properties) haciendo 
clic en el botón OK.

Cómo grabar un archivo de audio en Vista
El dispositivo predeterminado de entrada de audio para Grabadora 
de Sonidos es Microphone (Micrófono). Para cambiar el 
dispositivo o el volumen de grabación, consulte la sección siguiente 
“Cómo cambiar la entrada de audio y el volumen (Windows Vista)” 
en la página 41.

Para grabar y guardar un archivo de audio:

1.	 Haga clic en (Inicio > Todos los Programas > Accesorios > 
Grabadora de Sonidos) Start > All Programs > Accessories 
> Sound Recorder.

2.	 Haga clic en Iniciar Grabación (Start Recording).

Aviso: El chip de mensajes RMB9999 almacena hasta 30 
segundos de audio.

3.	 Para detener la grabación de audio, haga clic en (Detener 
Grabación (Stop Recording).

4.	 Seleccione una ubicación para el archivo haciendo clic en la 
flecha hacia abajo junto a la casilla desplegable Guardar en 
(Save in).

Creación de archivos de audio con Grabadora de sonidos
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5.	 Para guardar como archivo de audio el sonido grabado, haga 
clic en Save (Guardar).

Cómo cambiar la entrada de audio y el volumen  
(Windows Vista)

Para cambiar la entrada de audio y el volumen de grabación:

1.	 Haga clic en Inicio > Panel de Control > Hardware y Sonido 
> Dispositivos de audio (Start > Control Panel > Hardware 
y Sound > Manage audio devices), y haga clic en la pestaña 
Grabación (Recording).

2.	 Seleccione Línea de Entrada (Line In) o el nombre de otra 
entrada en línea o dispositivo que esté utilizando, y haga clic en 
Set Default (Establecer Predeterminado). 

3.	 Para ajustar el volumen, haga clic en Propiedades (Properties)  
y haga clic en la pestaña Niveles (Levels).

4.	 Para aumentar el volumen de grabación arrastre el control 
deslizante hacia la derecha. Para bajarlo, arrastre el control 
deslizante hacia la izquierda. 

5.	 Al terminar, haga clic en OK.

6.	 En la casilla de diálogo Sonido (Sound), haga clic en OK.

Cómo grabar un archivo de audio en Windows 7
El dispositivo predeterminado de entrada de audio para Grabadora 
de Sonidos es Microphone (Micrófono). Para cambiar el 
dispositivo o el volumen de grabación, consulte la sección siguiente 
“Cómo cambiar la entrada de audio y el volumen (Windows 7)” en la 
página 43.

Creación de archivos de audio con Grabadora de sonidos
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Para grabar y guardar un archivo de audio:

1.	 En la casilla Iniciar Búsqueda (Start Search), escriba 
Grabadora de Sonidos (Sound Recorder), y en la lista 
de resultados haga clic en Grabadora de Sonidos (Sound 
Recorder).

2.	 Haga clic en el botón (Iniciar Grabación) Start Recording.

	 Aviso: El chip de mensajes RMB9999 almacena hasta 30 
segundos de audio.

3.	 Para detener la grabación de audio, haga clic en Detener 
Grabación (Stop Recording).

4.	 Seleccione una ubicación para el archivo haciendo clic en la 
flecha hacia abajo junto a la casilla desplegable Guardar en 
(Save in).

5.	 Para guardar como archivo de audio el sonido grabado, haga 
clic en Guardar (Save).

Creación de archivos de audio con Grabadora de sonidos
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Cómo cambiar la entrada de audio y el volumen  
(Windows 7)

Para cambiar la entrada de audio y el volumen de grabación:

1.	 Haga clic en el botón Inicio (Start), después haga clic en Panel 
de Control (Control Panel.

2.	 En la casilla Iniciar Búsqueda (Start Search), escriba Sonido 
(Sound).

3.	 Haga clic en Sonido (Sound), después haga clic en la pestaña 
Grabación (Recording).

4.	 Haga clic en Línea de Entrada (Line In) o en el nombre de otra 
entrada en línea o dispositivo que esté utilizando, y haga clic en 
Establecer Predeterminado (Set Default).

5.	 Haga clic en Propiedades (Properties), después haga clic en 
la pestaña Niveles (Levels). 

6.	 Para aumentar el volumen de grabación arrastre el control 
deslizante hacia la derecha. Para bajarlo, arrastre el control 
deslizante hacia la izquierda, después haga clic en OK.

7.	 En la casilla de diálogo Sound (Sonido), haga clic en OK.

Creación de archivos de audio con Grabadora de sonidos
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Devolución del producto a cambio de crédito

Las devoluciones del producto a cambio de crédito por el mismo 
requieren una autorización de devolución de su distribuidor local antes 
de devolver el producto a Federal Signal. Póngase en contacto con su 
distribuidor para obtener ayuda. 

Un producto califica para ser devuelto a cambio de crédito cuando éste 
cumple las siguientes condiciones:

• 	 El producto se puede volver a vender y está en sus cajas 
originales

• 	 El producto no se ha instalado previamente

• 	 El producto es de la revisión actual

• 	 El producto no ha sido reparado previamente

• 	 El producto es un producto estándar

• 	 El producto no es una parte de repuesto

Todas las devoluciones están sujetas a un cargo de realmacenamiento.

Los productos defectuosos que se devuelvan dentro del período 
de la garantía serán reparados o reemplazados a discreción única 
de Federal Signal. Los productos defectuosos no incluyen aquellos 
productos con avería de lámpara.

Las circunstancias, otras que aquellas indicadas anteriormente, serán 
atendidas en base a caso por caso.
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Cómo obtener servicio, ayuda y repuestos

Los productos que se devuelvan para ser reparados requieren un 
formulario de Autorización de Devolución. Para obtener servicio para el 
producto, por favor comuníquese con el Departamento de Servicio de 
Federal Signal, al número 708-534-4858.

Para solicitar asistencia técnica, por favor llame al Servicio de Soporte 
Técnico de Federal Signal, al número 708-534-3424, extensión 5823. 

Para pedir partes de repuesto, por favor llame al Servicio de Asistencia 
al Cliente de Federal Signal, al número 708-534-4756.
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2645 Federal Signal Drive • University Park • IL 60484-3167
Tel: 708-534-4756 • Fax: 708-534-4852
elp@fedsig.com • www.federalsignal-indust.com
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Modèle 300FP-SD
Programmateur portable  

SelecTone®

Installation du logiciel et programmation  
du circuit intégré de message
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Federal Signal Corp.
Industrial Systems
2645 Federal Signal Drive • University Park, IL 60484-3167
Tel: 708-534-4756 • Fax: 708-534-4852
Email: elp@federalsignal.com • www.federalsignal-indust.com

Garantie – Le vendeur offre pour tous les produits une garantie de cinq ans sur 
les pièces et de 2,5 ans sur la main-d'œuvre, selon les conditions et exceptions 
suivantes : le vendeur garantit que tous les produits qu'il fabrique seront conformes 
aux descriptions correspondant aux spécifications qui font expressément partie de ce 
contrat de vente et qu'au moment de la vente par le vendeur, de tels produits devront 
être exempts de défauts de matériel et de fabrication. Le vendeur se réserve le droit, à 
sa discrétion, de « Réparer et retourner » ou «Remplacer » tout article jugé défectueux 
durant la période de garantie. Cette garantie ne couvre pas les frais de voyage, le coût 
de l'équipement spécialisé pour avoir accès au produit ou les frais de main-d'œuvre 
liés à l'enlèvement et à la réinstallation du produit. Cette garantie sera inopérante 
et ne s'appliquera pas aux produits qui ont subi un mauvais usage, une négligence, 
un accident, des dommages ou un entretien inapproprié, ou aux produits modifiés 
ou réparés par quelqu'un d'autre que le vendeur ou son représentant autorisé, ou si 
cinq ans se sont écoulés depuis la date de l'envoi des produits par le vendeur avec les 
exceptions suivantes : les lampes et les tubes stroboscopiques ne sont pas couverts par 
cette garantie. Les sirènes d'alarme extérieures et les appareils de contrôle fabriqués 
par Federal Warning Systems sont couverts par une garantie deux ans sur les pièces 
et de un an sur la main-d’œuvre. Aucun agent, employé, représentant ou distributeur 
du vendeur n'a autorité pour lier celui-ci à une représentation, affirmation, ou 
garantie relative au produit et une telle représentation, affirmation, ou garantie ne 
pourra pas être considérée comme faisant partie des généralités du contrat de vent 
et sera inexécutable. LES GARANTIES CI-DESSUS SONT EXCLUSIVES ET 
TIENNENT LIEU DE TOUTES LES AUTRES GARANTIES DE LA QUALITÉ 
MARCHANDE, DE COMPATIBILITÉ À UN USAGE PARTICULIER OU D'UN 
AUTRE TYPE, QU'ELLES SOIENT EXPRESSES OU IMPLICITES. Ces garanties 
ne s'appliqueront pas si le vendeur n'a pas la possibilité raisonnable d'enquêter sur 
toutes les réclamations de produits soi-disant défectueux. À la demande du vendeur, 
un échantillon seulement des produits soi-disant défectueux lui sera retourné pour 
inspection et approbation. La raison de toute réclamation pour de soi-disant défauts 
dans les produits ne pouvant être découverts après une inspection raisonnable en 
vertu du paragraphe 8 ci-contre doit être entièrement expliquée par écrit et reçue par 
le vendeur dans les trente jours après que l'acheteur ait pris connaissance du défaut 
ou une telle réclamation sera considérée comme nulle.
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SelecTone est une marque déposée de Federal Signal Corporation

InstallShield est une marque déposée et le marque de service d’InstallShield Corporation aux Etats-
Unis ou à d’autres pays

 Windows est une marque déposée de Microsoft Corporation aux Etats-Unis et à d’autres pays.
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Description générale du modèle 300FP-SD

L’application de Federal Signal du modèle 300FP-SD de programmateur 
portable SelecTone® copie des fichiers audio depuis votre ordinateur 
vers le circuit intégré de message RMB9999 de Federal Signal placé 
sur le programmateur portable SelecTone. Le circuit intégré de message 
peut enregistrer jusqu’à 30 secondes de signal audio. 

Les fichiers audio sont créés avec l’application Magnétophone 
disponible dans Windows® XP, Windows Vista et Windows 7, ou tout 
autre programme tiers d’enregistrement et d’édition de sons. Les circuits 
intégrés de message sont compatibles avec le CommCenter® de 
Federal Signal et le module de haut-parleur modèle TM33. Ils peuvent 
être réutilisés et reprogrammés.

Le programmateur portable SelecTone dispose notamment d’un 
mécanisme d’insertion du circuit intégré de message qui le verrouille 
facilement en place, d’un contrôle d’enregistrement du message et 
d’une commande de volume sonore. Des témoins à DEL s’allument 
lorsque le programmateur est sous tension (vert) et durant l’exécution du 
contrôle d’enregistrement (rouge). Le témoin à DEL rouge de contrôle 
d’enregistrement clignote rapidement quand le programmateur portable 
SelecTone tente de lire un circuit intégré vierge. 

L’emballage comprend :

Description Numéro de pièce

Programmateur portable 300FP-SD SelecTone 2005625
Adaptateur de courant 120 V ca à 24 V cc 120834
RS-232 Serial Cable 1751156
Installation CD 8503058

Les circuits intégrés Federal Signal peuvent être achetés séparément 
sous le numéro de pièce RMB9999.

Caractéristiques de l’appareil

Adaptateur de courant :
Entrée : 110 V–120 V, 50/60 Hz

Homologué UL

Exigences audio: WAV
MP3
WMA (avec Media Player de Windows 
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Configuration requise de l’ordinateur :

Windows XP, Windows Vista ou Windows 7
Définition d’écran : 1024 x 768 pixels, 32 bit
Espace libre sur disque dur : 20 Mo
Un port série libre
Carte graphique de 64 Mo

Description générale du modèle 300FP-SD
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Installation du logiciel

Pour installer le logiciel du programmateur portable SelecTone :

1.	 Insérer le CD d’installation dans le lecteur CD/DVD de votre 
ordinateur.

2.	 Si l’option Autorun est désactivée, cliquer deux fois sur le fichier 
setup.exe du CD.

3.	 I Si votre système ne dispose pas de Microsoft.NET Framework 
3.5 SP1 runtime, InstallShield® Wizard (guide d’installation 
InstallShield®) vous invitera à l’installer. Cliquer sur Install 
(Installer).

Si votre système dispose du composant requis .NET Framework, 
passer à l’étape 5.
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4.	 Les fichiers .NET Framework peuvent prendre quelques minutes 
pour s’installer. 

Remarque : Il sera peut être nécessaire de redémarrer 
l’ordinateur une fois l’installation achevée.

5.	 Quand InstallShield® Wizard apparaît pour le logiciel du 
programmateur portable SelecTone, cliquer sur Next (suivant).

6.	 Suivre les instructions affichées sur l’écran pour achever 
l’installation.

 Installation du logiciel
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Exploration de l’interface

Programmer des circuits intégrés de message avec l’application du 
programmateur portable SelecTone est à la fois rapide et facile. Le 
processus de programmation, simple, en trois étapes, est indiqué dans 
une seule fenêtre :

Étape 1	 Sélectionner le port série qui est connecté au 
programmateur portable SelecTone.

Étape 2	 Sélectionner un fichier audio à programmer sur le circuit 
intégré de message.

Étape 3	 Commencer la programmation.

En outre, l’application marque chaque étape correctement achevée 
avec un signe de pointage vert (✔ = correct). e étape correctement 
achevée avec un signe de pointage vert (⎫= correct). Pour s’assurer que 
le fichier audio est copié correctement, l’application arrête le processus 
à la première étape contenant une erreur et marque cette étape avec 
un X roug (✖ =  échec).  

Boutons Réduire et 
Fermer

Menu 
Options

Message 
d’état du 

processus

Bouton 
Actualiser

Bouton 
Parcourir

Étape 1 du 
programme

Étape 2 du 
programme

Étape 3 du 
programme
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Les boutons Réduire (–) et Fermer (X) dans l’angle supérieur 
droit agissent de la même façon que leurs homologues dans les 
autres programmes Windows. Le bouton Réduire réduit la taille de 
l’application, sans la fermer, à une icône sur la barre de tâche. Une fois 
prêt à vous servir de l’application, cliquer sur l’icône pour y accéder 
rapidement. Cliquer sur le bouton Fermer pour fermer l’application. 

Les boutons qui sont communs aux autres programmes fonctionnant 
sous Windows sont le bouton Actualiser de l’étape 1 et le bouton 
Parcourir de l’étape 2. Cliquer sur le bouton Parcourir pour naviguer 
jusqu’au fichier audio à programmer dans le circuit intégré de message.

La boîte État au bas de la fenêtre fournit des informations détaillées 
sur les raisons du succès ou de l’échec de chaque étape.

Menu Options
L’application du programmateur portable SelecTone dispose d’un 
menu d’options qui permet de changer la langue de l’interface, 
de gérer les fichiers et de mettre en œuvre la programmation des 
circuits intégrés de message. Les quatre sous-menus et leurs 
fonctions sont:

Fichier

Ouvrir Ouvre un fichier audio

Quitter Quitte l’application

Edition

Couper Coupe du texte dans les champs 
d’application tels que noms de fichier et 
messages d’état

Copier Copie du texte dans les champs 
d’application

Coller Colle du texte dans les champs 
d’application

Exploration de l’interface
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Menu Options (suite)

Outils

Informations du 
fichier audio

Affiche le type, la fréquence 
d’échantillonnage et le nombre de bits du 
fichier audio

Canal audio Sélectionne le canal audio assurant le 
téléchargement vers le circuit intégré

Actualiser la liste 
des ports série

Relance l’analyse des ports série 
disponibles sur l’ordinateur Fonctionne de 
la même façon que le bouton Actualiser 
de l’étape 1

Langue Change la langue de l’interface 
d’application en anglais (par défaut), en 
français ou en espagnol

Aide

A propos... Affiche le numéro de modèle du 
programmateur portable SelecTone, 
le numéro de version du logiciel et les 
informations de droit d’auteur de Federal 
Signal

Exploration de l’interface
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Préparation de la programmation d’un circuit 
intégré de message

Pour préparer la programmation avec le modèle 300FP-SD : 

1.	 Brancher le câble série entre le port série de l’ordinateur et le 
connecteur série sur le programmateur portable SelecTone.

2.	 Brancher le câble de l’adaptateur de tension entre une source 
d’alimentation de 120 V ca et le connecteur d’alimentation sur le 
programmateur portable SelecTone.

3.	 Insérer un circuit intégré de message vierge sur le programmateur 
portable SelecTone, en plaçant l’encoche à gauche.  

4.	 Quand le circuit intégré est complètement inséré, basculer le levier 
de verrouillage sur la gauche et vers le bas pour l’immobiliser.

Câble 
série vers 

l’ordinateur 

La DEL verte est 
allumée quand 

l’appareil est 
sous tension

Circuit intégré de 
message inséré 

avec l’encoche à 
gauche

Adaptateur de ten-
sion vers la source 
d’alimentation

Levier en position 
verrouillé

La DEL rouge est 
allumée lors de la 
lecture du circuit 
intégré de mes-
sage; elle clignote 
rapidement quand  
il est vierge

Tourner dans le 
sens horaire pour 
augmenter le vo-

lume sonore; dans 
le sens antihoraire 

pour le diminuer

Haut-parleur
Appuyer pour 
commencer le 
contrôle d’enre-
gistrement du 
circuit intégré de 
message
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Programmation d’un circuit intégré de message

Le circuit intégré de message RMB9999 peut être réutilisé et 
reprogrammé. La longueur maximale du message est de 30 secondes.

Pour programmer un circuit intégré de message :

1.	 Lancer le logiciel de programmation en cliquant sur l’icône 
SelecTone Field Programmer sur le bureau ou à partir du Start 
Menu en sélectionnant All Programs > Federal Signal > 
SelecTone Field Programmer.

2.	 Dans la fenêtre de programmation, à l’étape 1, sélectionner un 
port série par lequel le fichier audio sera téléchargé.

3.	 À l’étape 2, saisir le chemin d’accès et le nom du fichier audio,  
ou cliquer sur le bouton Parcourir à l’étape 2 pour naviguer vers  
le fichier. Alternativement, dans la barre de menu cliquer sur  
Fichier > Ouvrir et sélectionner le fichier audio à télécharger. 

Bouton 
Parcourir
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4.	 Si le fichier audio dispose de plus d’un canal, sélectionner dans le 
menu Outils le canal audio à télécharger. Le canal par défaut est 
canal 1. La quantité de canaux disponibles est déterminée par le 
fichier audio sélectionné.

5.	 Cliquer sur Programmer à l’étape 3 pour télécharger le fichier 
audio vers le circuit intégré de message. 

6.	 Pour écouter le message enregistré, appuyer sur le bouton Lire 
sous la flèche du programmateur portable SelecTone. Consulter la 
figure de la page 58.

Remarque : Pour régler le volume sonore durant le contrôle 
d’enregistrement, utiliser un petit tournevis Phillips ou à lame 
plate et faire tourner la commande de Volume encastrée dans le 
sens horaire pour augmenter le volume sonore ou dans le sens 
antihoraire pour le diminuer.

7.	 Basculer le levier de verrouillage en position verticale et retirer 
avec précaution le circuit intégré programmé de son support. 

8.	 Pour continuer à programmer des circuits intégrés supplémentaires 
à partir du même fichier audio, il suffit de cliquer sur le bouton 
Programmer après avoir inséré un circuit intégré vierge.

Programmation d’un circuit intégré de message
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Production de fichiers audio avec  
Magnétophone (Sound Recorder)

Magnétophone (Sound Recorder) est un utilitaire, d’emploi facile, inclus 
dans le système d’exploitation Windows, pour enregistrer et éditer des 
fichiers audio. Ce chapitre décrit comment enregistrer un fichier audio 
avec Magnétophone sous Windows XP, Windows Vista et Windows 7. 
Avant d’utiliser Magnétophone, vérifier que l’ordinateur est bien équipé 
d’une carte son, de haut-parleurs et d’un dispositif d’entrée audio tel 
qu’un microphone.

Enregistrement d’un fichier audio sous Windows XP
Le dispositif d’entrée audio par défaut pour Magnétophone 
est Microphone. Pour changer d’entrée audio ou de niveau 
d’enregistrement, se reporter à la section suivante « Changement 
de l’entrée audio et du niveau d’enregistrement (Windows XP) » en 
page 62.

Pour enregistrer et sauvegarder un fichier audio :

1.	 Cliquer sur Démarrer > Programmes > Accessoires > 
Divertissement > Magnétophone (Start > Programs > 
Accessories > Sound Recorder).

2.	 Pour commencer l’enregistrement, cliquer sur le bouton Lecture 
(point rouge). 

Remarque : Le circuit intégré de message RMB9999 peut 
enregistrer jusqu’à 30 secondes de signal audio.

3.	 Pour arrêter l’enregistrement, cliquer sur le bouton Arrêt (carré 
noir). 
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4.	 Quand l’enregistrement est terminé, cliquer sur Fichier > 
Enregistrer (File > Save).

5.	 Cliquer dans la boîte nom du fichier et taper un nom du fichier 
pour le son enregistré.

6.	 Sélectionner un emplacement pour le fichier en cliquant sur 
la flèche pointant vers le bas à côté de la zone déroulante 
Enregistrer en (Save in).

7.	 Pour sauvegarder le son enregistré sous un fichier audio, cliquer 
sur Enregistrer.

Changement de l’entrée audio et du niveau  
d’enregistrement (Windows XP)

Pour changer l’entrée audio et le niveau d’enregistrement :

1.	 Dans le menu principal de Magnétophone, sélectionner  
Édition > Propriétés audio (Edit > Audio Properties).

Production de fichiers audio avec Magnétophone (Sound Recorder)
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2.	 Sous Enregistrement du son (Sound Recording), cliquer sur 
le bouton Volume.

3.	 Dans le panneau de configuration Contrôle d’enregistrement 
(Recording Control), cocher la boîte Select sous Entrée ligne 
(Line In) ou le nom d’une autre entrée ligne ou dispositif utilisé.

Production de fichiers audio avec Magnétophone (Sound Recorder)
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4.	 Augmenter le niveau ou Volume d’enregistrement en déplaçant 
le curseur vers le haut. Le diminuer en déplaçant le curseur vers 
le bas.

5.	 Fermer Contrôle d’enregistrement (Recording Control) en 
cliquant sur le bouton X.

6.	 Fermer Propriétés audio (Audio Properties) en cliquant sur le 
bouton OK. 

Enregistrement d’un fichier audio avec Windows Vista
Le dispositif d’entrée audio par défaut pour Magnétophone 
est Microphone. Pour changer d’entrée audio ou de niveau 
d’enregistrement, se reporter à la section suivante « Changement 
de l’entrée audio et du niveau d’enregistrement (Windows Vista) » 
en page 65.

Pour enregistrer et sauvegarder un fichier audio :

1.	 Cliquer sur Démarrer > Tous les programmes > Accessoires 
> Magnétophone (Start > All Programs > Accessories > 
Sound Recorder.

2.	 Cliquer sur Démarrer l’enregistrement (Start Recording).

Remarque : Le circuit intégré de message RMB9999 peut 
enregistrer jusqu’à 30 secondes de signal audio.

3.	 Pour arrêter l’enregistrement audio, cliquer sur Arrêter 
l’enregistrement (Stop Recording).

4.	 Sélectionner un emplacement pour le fichier en cliquant sur 
la flèche pointant vers le bas à côté de la zone déroulante 
Enregistrer en (Save in).

Production de fichiers audio avec Magnétophone (Sound Recorder)
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5.	 Pour sauvegarder le son enregistré sous un fichier audio, cliquer 
sur Enregistrer (Save).

Changement de l’entrée audio et du niveau d’enregistrement 
(Windows Vista)

Pour changer l’entrée audio et le niveau d’enregistrement :

1.	 Cliquer sur Démarrer > Panneau de configuration > Matériel 
et son > Gérer les périphériques audio (Start > Control 
Panel > Hardware and Sound > Manage audio devices), et 
cliquer sur l’onglet Enregistrement (Recording).

2. 	 Sélectionner Entrée ligne (Line In) ou le nom d’une autre 
entrée ligne ou source utilisée, et cliquer sur Définir par défaut 
(Set Default). 

3. 	 Pour régler le niveau, cliquer sur Propriétés et cliquer sur 
l’onglet Niveaux (Levels). 

4. 	 Augmenter le niveau d’enregistrement en faisant glisser le 
curseur vers la droite. Le diminuer en faisant glisser le curseur 
vers la gauche. 

5. 	 Quand l’enregistrement est terminé, cliquer sur OK.

6.	 Dans la boîte de dialogue Son (Sound), cliquer sur OK.

Enregistrement d’un fichier audio avec Windows 7
Le dispositif d’entrée audio par défaut pour Magnétophone 
est Microphone. Pour changer d’entrée audio ou de niveau 
d’enregistrement, se reporter à la section suivante « Changement 
de l’entrée audio et du niveau d’enregistrement (Windows 7) » en 
page 67.

Production de fichiers audio avec Magnétophone (Sound Recorder)
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Pour enregistrer et sauvegarder un fichier audio :

1.	 Dans la boîte Recherche (Start Search), taper magnétophone 
(sound recorder), et dans la liste des résultats, cliquez sur 
Magnétophone (Sound Recorder).

2.	 Cliquer sur le bouton Démarrer l’enregistrement (Start 
Recording).

Remarque : Le circuit intégré de message RMB9999 peut 
enregistrer jusqu’à 30 secondes de signal audio.

3.	 Pour arrêter l’enregistrement audio, cliquer sur Arrêt 
l’enregistrement (Stop Recording).

4.	 Sélectionner un emplacement pour le fichier en cliquant sur 
la flèche pointant vers le bas à côté de la zone déroulante 
Enregistrer en (Save in).

5.	 Pour sauvegarder le son enregistré sous un fichier audio, cliquer 
sur (Enregistrer) Save.

Production de fichiers audio avec Magnétophone (Sound Recorder)
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Changement de l’entrée audio et du niveau (Windows 7)

Pour changer l’entrée audio et le niveau d’enregistrement :

1.	 Cliquer sur le bouton Démarrer (Start), puis cliquer sur 
Panneau de configuration (Control Panel).

2.	 Dans la boîte Recherche (Start Search), taper son (sound).

3.	 Cliquer sur Sound, puis cliquer sur l’onglet  Enregistrement 
(Recording).

4.	 Cliquer sur Line In ou sur le nom d’une autre entrée ligne 
utilisée, et cliquer sur Définir par défaut (Set Default). 

5.	 Cliquer sur Propriétés et cliquer sur l’onglet Niveaux (Levels). 

6.	 Augmenter le niveau d’enregistrement en faisant glisser le 
curseur vers la droite. Le diminuer en faisant glisser le curseur 
vers la gauche, puis cliquer sur OK.

7.	 Dans la boîte de dialogue Son (Sound), cliquer sur OK.

Production de fichiers audio avec Magnétophone (Sound Recorder)
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Renvoi de l’appareil pour obtenir  
un remboursement

Avant de renvoyer l’appareil à Federal Signal en vue d’obtenir un 
remboursement, vous devez obtenir une autorisation de renvoi auprès 
de votre distributeur local. Veuillez contacter votre distributeur afin 
d’obtenir de l’aide. 

Un appareil peut être renvoyé afin d’obtenir un remboursement si les 
conditions suivantes sont respectées :

• 	 L’appareil est en état d’être revendu et dispose de son 
emballage d’origine

• 	 L’appareil n’a jamais encore été installé

• 	 L’appareil est du modèle le plus récent

• 	 L’appareil n’a jamais été réparé

• 	 L’appareil est un produit normalisé

• 	 L’appareil n’est pas une pièce détaché

Tous les renvois font l’objet de frais de restockage.

Les appareils défectueux renvoyés au cours de la période de garantie 
seront réparés ou remplacés selon le bon vouloir de Federal Signal. 
Les appareils dont une lampe est défaillante ne sont pas considérés 
comme des produits défectueux.

Toutes les circonstances autres que celles citées ci-dessus seront 
examinées au cas par cas.
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Obtention de réparation, d’assistance et de piè-
ces de rechange

Les appareils renvoyés pour être réparés doivent être accompagnés 
d’un formulaire d’autorisation de renvoi. Pour obtenir la réparation de 
votre appareil, veuillez contacter le service après-vente de Federal 
Signal au 708-534-4858.

Pour obtenir une aide technique, veuillez appeler le support technique 
de Federal Signal au 708-534-3424, poste 5823. 

Pour commander des pièces de rechange, veuillez appeler le service à 
la clientèle de Federal Signal au 708-534-4756.



2645 Federal Signal Drive • University Park • IL 60484-3167
Tel: 708-534-4756 • Fax: 708-534-4852
elp@fedsig.com • www.federalsignal-indust.com




